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RealProducer™ Plus 8.5 ~
Broadband Video Production Specifications

The following documentation details key information for encoding high bit rate broadband
streaming video content using the RealProducer Plus 8.5. The information is based upon
production work completed specifically for Broadband encoding, in accordance with
development from the Codec and Tools teams at RealNetworks from February, 1999, to
November, 2000.

In reading through the specifications you will learn:
= Specifics of ramping up your video inputs to match Broadcast compatible standards.
®" How to target the highest possible Video Capture and exporting to Uncompressed AVI.

®=  Methods of using the RealProducer Plus 8.5 encoding settings including “High Quality
Resize”, “Low Noise”, “De-Interlace” and “Inverse Telecine” filters.

New Features of RealProducer Plus 8.5
®  The Best Quality Streaming Video on the Market Today.

®"  Higher Quality Audio at Lower Bit Rates! Low Bit rate Stereo Music and Sony ATRAC3
codecs designed to greatly improve the quality of audio in the range between 12 Kbps to
352 Kbps.

®= Near VHS quality at 500 kbps bit rate. Near DVD quality at 1.0 MBps bit rate.
®=  No limit on input AVI file sizes. Reading files over 2 GB is now possible.

®" Film and Television frame rates at 24 —using Inverse Telecine, or 30 fps.

RealProducer Plus 8.5 will enable you to create the best quality, most competitive streaming
video for any target audience. RealVideo 8.5 media is now optimized for bit rates up to 5 Mbps
at real time, 30 fps, full-screen playback.

Additional features improving video quality include both “Two-pass Analysis” and “Variable Bit
rate” (VBR) encoding modes.

Updated features include filters for “De-Interlace”, “Inverse Telecine”, and “High Quality
Resize”, all of which remove artifacts that tend to occur in all high-resolution video capture
processes.
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Descriptions of Features in the RealProducer Plus 8.5

Two Pass Analysis
Analyzes the individual frames of the source video file prior to encoding.
Redistributes bits within the encoded file, resulting in a noticeable improvement in the resulting
encoded video quality. Will increase encode processing time by more than a factor of two.
Variable Bit Rate Encoding

Increases quality of streaming video by allocating bits as bit rate is varied in playback. Allows
greater variation in bit rate allocation. Allows the user to increase the startup latency of the
encoded clip to increase video quality. May increase the startup latency of the encoded clip.

De-Interlace Filter

Removes interlace artifacts from NTSC or PAL video input. Ideal for full screen (720x486 to
640 x480) video source.

Inverse Telecine Filter

Removes redundant frames or fields from video content. Should be used with content that
was originally converted from 24 fps film to 30 fps video in a 3:2 pulldown process.

High Quality Resize Filter

Greatly improves video quality when resizing. Requires slightly longer processing time.

Loss Protection

Protects against packet loss by adding error correction codes and more keyframes to the video
stream when possible. A dynamic algorithm that has minimal impact on quality, suitable for all
streamed content.

Low Noise Filter

The noise filters are improved to make it easier to encode grainy or noisy material.
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Targeting Broadband Video — General Guideline Overview

This information is to provide best targets for encoding RealVideo8 with the RealProducer Plus, 8.5 Beta or
future Gold release The targets listed below provide excellent results for low to high action media.

"Best results are obtained USING the settings of VBR, Two Pass Analysis, Low Noise Filter, HQ Resize, De-
Interlace Filter (if video source), Inverse Telecine (if film source), and cropping all black edges and over-
scanned captures. "

Single Rate Video

Window Target Bit Rate Audio (Voice) Audio (Music) Frame Rate

Aspect ~4:3 TV ratio

640w X 480h 1000 kbps 64-96 k/s -RA8 stereo 96-132 k/s -RA8 stereo 30 fps

480w x 360h 750 kbps 44 to 64 kis -RA8 stereo  64-96 k/s -RA8 stereo 30 fps

320w x 240h 500 kbps 44 to 64 kis -RA8 stereo  44-64 k/s -RA8 stereo 30 fps

240w x 180h 220 kbps 32 to 44 kis -RA8 stereo  32-44 k/s -RA8 stereo 30 fps

16:9 letterbox

640w x h 750 kbps 64 to 96 k/s -RA8 stereo 96 to 132 k/s -RA8 stereo 30 fps

480w x h 500 kbps 4 10 64 k/s -RA8 stereo 64 to 96 k/s -RA8 stereo 30 fps

320w x h 400 kbps 44 to 64 kis -RA8 stereo 44 to 64 k/s -RA8 stereo 30 fps

240w x h 220 kbps 32 to 44 kis -RA8 stereo 32 to 44 k/s -RA8 stereo 30 fps

SureStream Video

Window Target Bit Rate  Audio (Voice) Audio (Music) Frame Rate

Aspect ~4:3 TV ratio

320w x 240h 300 kbs 44 k/s -RA8 stereo 64 k/s -RA8 stereo 30 fps
220 kbs 32 k/s -RAS8 stereo 44 k/s -RA8 stereo 30 fps

176w x 132h 100 kbs 16 k/s -RA8 stereo 20 k/s -RA8 stereo 15 fps
34 kbs 8.5 k/s -voice 11k/s -music 15 fps
20 kbs 6.5 k/s -voice 8 k/s -music 15 fps

16:9 letterbox

320w x h 300 kbs 44 to 64 k/s -RA8 stereo 64 k/s - RA8 stereo 30 fps
220 kbs 32 to 44 kis -RA8 stereo 44 k/s - RA8 stereo 30 fps

176w x h 100 kbs 16 k/s - RA8 stereo 20 k/s - RA8 stereo 15 fps
34 kbs 8.5 k/s - voice mono 11k/s - music mono 15 fps
20 kbs 6.5 k/s - voice mono 8 k/s - music mono 15 fps
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General Target Guidelines:
Above 200kbps

Average 30 fps in 320 pixel window width or greater

Below 200 kbps

Average 15 fps in 200 pixel window width or smaller

For RealAudio8 Audio Only:

Audio Single Rate
Bit Rate Audio (Voice)

Audio (Music)

96 kbs 96 kbs - RA8

Audio SureStream

96 kbs - RA8

Bit Rate Audio (Voice) Audio (Music)
64 kbs 64 kbs - RA8 64 kbs - RA8
32 kbs 32 kbs - RA8 32 kbs - RA8
20 kbs 20 kbs - RA8 20 kbs - RA8

Quality of Content Type & Source Media:

"Content quality can vary depending on quality of source media: higher quality video formats such as
Beta SP analog or any digital format will encode particularly well. Video capture cards input can very -
component and/or digital inputs provide an optimum capture source at for higher bit rates above
300kbps. For on-demand video, make sure your source capture is saved in a uncompressed file

format: the RealProducer Plus 8.5 can now work with files over 2 GB in size."

"Content that is particularly low action, such as "talking heads™, will encode well -you may want to

increase your window size or decrease your bit rate to save bandwidth. "

"Content that is particularly high action and shot on video, such as sports footage, you may want to

decrease the frame rate below 15 fps for lower bandwiths below 200 kbps. "

©2000 RealNetworks, Inc.
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Setting-up the Computer Platform for Capture and Encoding:

The majority of high bit rate media generated in the RN Broadband Lab has been developed
on the Windows platform under the following perimeters:

oS Windows NT, 98, 2000 or Macintosh

Processor 400 MHz or greater processor. Suggested: PIII-800+

RAM 128 MB —best for full screen 720x486 video capture and encoding
RealPlayer Best method: RealPlayer8— auto update on players

Note: The information provided below is based on setting up a capture system for Windows
capture and encoding. The Mac RealProducer Plus 8.5 provides the same exact features as
the Windows-based tool and results in the same encode when using the exact same
settings as with the RealProducer plus for Windows.

Video/Graphics Display Cards

Using an optimized Video Display card on your system will enhance the capture, display and
playback of high bit rate video media.

Cards such as the ATl Rage128 Pro-based series perform well with full screen playback using
the RealPlayer.

Video capture card manufacturers may also suggest specific cards for optimized performance.

Using Optimized Video Data Arrays

Unless you are able to optimize your hard drive for high speed A/V data capture, you will want
to purchase a video array to maintain a constant 30 fps high level data transfer rate.

It is suggested to use at least 30 GB video raids for high bit rate encoding. The Rourke and
Media brand products are high capacity expandable SCSI and Ultra SCSI LVD arrays
available for all of Mac, NT and UNIX systems.

Investigating Video Capture Cards For Video Capture to AVI File Generation:
Analog Input Source Video Cards:

There are a number of cards -as well as cards integrated with edit systems, on the market
which provide a breakout box for Component cable input.

The Miro DC50 card with breakout box, from Pinnacle, provides ITU-R 601 broadcast
industry standard image output, from full screen, 720x486 NTSC to 352x240 or 640x486.

Digital Input Source Video Cards:

There a several IEEE-1394 cards on the market to choose from, however some cards do
not provide highest quality Uncompressed AVI's. Testing is suggested.

Look for a card that captures an Uncompressed DV 720x480 resolution, and provides an
NTSC broadcast industry standard image output at full screen ITU-R 601 quality.

Investigating Video Capture Cards For Video Capture Direct to RealServer or .RM file
Live Video Input to RealProducer:

Targeting higher broadcast quality streaming video at bit rates above 220 kbps, there are
several high-end solutions in the broadband-targeted live card space. Several SDI input
products from Pinnacle currently provide high quality live encoding solutions. Look for
additional SDI input products from various hardware companies in Q1 of 2001.

Towards bit rates below 220 kbps, existing Brooktree based video card live solutions
continue to provide acceptable performance for 320x240 windows, at 15-30 fps video
frame rates.
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Wiring & Cabling the Video Input System
Video — Analog Inputs:

Component input, using separate BNC cables for the Y, R-Y, B-Y and Reference signals
from Beta SP, provides an optimal broadcast source capture. Composite and S-Video are
typically used as input for streaming narrow band web video, but do not provide the
highest quality results for broadband media. If Component is not an option then S-Video
is preferable to composite.

Video — Digital Inputs:

Mini DV IEEE-1394 input from a DV deck or camera can provide high quality source if
using a quality DV capture card. Some DV cards may add artifacts to the capture. Test
and view the results of an Uncompressed AVI export before using or purchasing. See
notes on cards below.

Suggested Video Capture Card Input Cabling:

These signals will transmit the data rate and resolution to create an optimum broadband
source. Requires the use of higher end video capture cards that provide 1/O breakout
boxes and/or direct inputs as listed:

=  Component (Y, RY, BY)
= |EEE-1394, "Firewire"
® CCIR-601, Serial Digital

The following formats will not transmit the data rates or resolution for an optimum
broadband source but can certainly function for creating high bit rate video:

"  S-Video
®  Component BNC

®  Component RCA

Source Material for Optimal Encoding

Use Broadcast Quality Video Tape Source

Recommended Broadcast Source Video Formats:
= Digital Beta, D-1, D-2, D-5
®=  High Definition Digital Wide screen: HD CAM or HDD5
" Beta SP
= DV CAM (Sony) or DVC PRO (Panasonic)
=  Mini DV, IEEE-1394

=  U-matic, 3/4” (if there is no other option in the above formats)

Analog Video Source:

For Analog formats the best quality broadcast source is Beta SP, using Component
cabling into your capture system.

U-matic 3/4” also applies if this is the only format available. Tests indicate quality
differences between the two formats when using appropriate video input connections,
Beta SP proves to be cleaner than 3/4”".
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Avoid capturing off VHS altogether- the format is rarely used in Broadcast TV production,
the quality will appear degraded once used in broadband video creation.

Digital Video Source:

The following Digital Broadcast ITU-R 601 formats all provide high quality source media:
Digi-Beta, D-1, D-2, D-5; or High Definition Digital HD CAM or HDD5; or DVC Pro 25
(Panasonic), DV CAM (Sony); or IEEE-1394 Consumer Mini DV.

Post-Production facilities equipped with high-end editing or graphics systems can capture
from any of the quality digital video formats listed above. Using a capture card with Serial
Digital inputs will provide very high quality source, as long as the capture/edit system
allows for a high-quality AVI file export.

Preparing the Source AVI

Capture Settings, Frame Rate, Data Rate

Capture at a frame rate of 30 fps, Uncompressed or MJPEG 24 or 32 bit RGB color, 16 Kbps,
44 kHz stereo audio or greater.

Set the video capture data rate to the maximum settings that your card allows: near 2400
KiloBytes/sec for 352x240 windows, to near 7200 KiloBytes/sec for 720x486 windows.

Redo your capture if the system reports frame dropping during the capture process.

For highest quality broadband video, we suggest capturing fullscreen video and allowing the
“High Quality Resize Filter” in the RealProducer to resize your media.

Capture Window Size Settings

Full screen settings for optimum video source captures:

720 x 486 CCIR-601 or ITU-R 601 Serial Digital - 4:2:2 color sampled
720 x 480 “DV” IEEE-1394
640 x 480 “TV Square Pixel Aspect Ratio”
Quarter screen settings for optimum video source captures:
352 x 240 (Default capture setting on some video cards)
320 x 240 “CIF — Square Pixel”

Adding fades to the audio and video at the heads and tails of the clips provides a smooth
transition in playback; ending on a black frame is cleaner than allowing the player to end on a
final image of the video clip.

Exporting to AVI or MOV

When exporting to AVI, maintain those same settings as per the captured digital video source;
keeping the window size, audio, and color depth the same.

Make sure the color depth setting is set to millions.

Allow the RealProducer Plus 8.5, to do the resizing, filtering and cropping. You will find best
results are achieved when working from the highest quality, uncompressed AVI's.

Follow the information in the next section on working with the 2 GB file size limit under
Microsoft Windows OS.

NOTE: The same settings apply supporting 24 or 32 bit RGB .MQV file formats. Third party
encoding tools such as Media Cleaner 5 from Terran support the RealProducer Plus 8 export
to the RealVideo format on both Windows and Mac Platforms.
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Creating Uncompressed AVI's Over 2 GB
Support for AVI 2.0
Files over 2 GB can now be encoded with the RealProducer Plus 8.5.
Encode superior quality RealVideo8 feature films and television programming.

Uncompressed file sources at 720x486 window sizes, utilizing over 200 GB of disc space, can
be used as input into the RealProducer Plus.

Simply ensure the codec to read the AVI 2.0 file is available on your encoding system, while
providing at least 128 to 256 MB of RAM.

* Check with your capture card vendor for high quality capture cards that allow for
uncompressed AVI source captures over 2 GB. If file is unreadable — look for a shareware
program on the internet, “Virtual Dub”, which allows for converting file formats without affecting
the compression of the video file.

Creating Uncompressed AVI's within the 2 GB File Size Limit

Instructions for users with video cards that only capture 2 GB files

Capture at file size less than or near to 2 GB, the maximum size of the Microsoft Windows AVI
file format.

Experimentation with long duration video sequences from 12 minutes to 1 hour is encouraged,
but requires more work on the encoding preparation side. Files CAN be pieced together with
the RealEditor tool, as long as all encoding settings are the same.

The first step in exporting to the AVI file format is testing: run a few AVI export tests with a 10-
15 second sequence to determine the maximum length of uncompressed video you can
achieve under the 2 GB file size limit. Then test importing the particular AVI into the
RealProducer Plus.

For long format clips with durations above 12 minutes -given the 2 GB AV file size
limitation, the sequence requires exporting AVI's in 2 GB increments from your timeline.

First, determine the number of minutes you can export within 2 GB. Then select the first frame
and last frame of the duration on your media timeline. On your next export, select the following
frame after your last output as the first frame of this export extending down the timeline within
the total 2 GB duration allowed. Once export of your timeline is complete, encode the
individual exported clips with exact same windows sizes, cropping and settings. Lastly, edit
the clips together again in sequential order with the .RM editor tool included within the
RealProducer Plus interface. Again, the maximum length to export your clips again depends
on which AVI codec you are using.
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Using RealProducer Plus 8.5 Settings for High Bit rate Encoding

The following information details how to use the settings within the RealProducer Plus 8.5
to create high quality broadband video.

Selecting Video Filters

FPreferences Ed

General | Suretioam | Lirve Broadoast
VidoFle | VideoCodec | Advanced
Hoite Fiber Fesize Fite
i s (¥ Fast Resze
Fikes Low Howe € High Qually Resize

" Fibes High Moisa

I Ireverze-Tedecrs Mare [nfo..

Removes redundant rames [rom vadeo content. Should
bee teped wath cordert that was conrerted From 24 fps Bm
Lo 30 s wideo:

[T [De-inteclace Fiter Mors nfio...

Removes riedace alifacts fiom M TSC o PAL video rpul.
Will orily alfect videa input walth & height of 240 bnes o
greabes. The: fiter should not be used with nondntedaced
wideo,

0k | Cancel Help

Image details the dialog box for Advanced Preferences under the Options menu.

Recommended Settings:
Noise Filter: Using the Low Noise filter will optimize most video source.

Video Filters: Select either “De-Interlace Filter” or “Inverse Telecine” depending on the
content source type. (Read On...)

Resize Filter: Set to “High Quality Resize”.

Noise Filter

The Low Noise Filter was re-tuned in the Gold release of RealProducer 8.0, to make this filter
useful for low level graininess that can occur even in video captures from high quality sources
like Beta SP or various Digital Video formats.

Tip: If you single-step through the original AVI with the window double-sized, and any kind of
noise is apparent, we suggest that you enable the Low Noise pre-filter in Options-
>Preferences->Video Filter. The Low Noise filter is now quite conservative but clearly reduces
subtle noise artifacts and graininess on surfaces with solid color or textured areas within a
video image.
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After encoding, check to see if, in the playback of the video stream, the compressed video
flickers in areas with low motion, it is probably a good idea to re-encode with the low noise pre-
filter enabled.

Noise Filter Continued:

The High Noise Pre-filter is more aggressive, and will add artifacts. Hence, it should be
enabled only for material with high levels of noise.

Inverse Telecine

For 24 fps film transferred to video such as, feature films, music videos, etc., select “ Inverse
Telecine Filter” unchecking “De-interlace Filter”.

When the source material is from 24 fps film, and then converted to 29.97 fps for tape
recording, the Inverse Telecine filter in should be enabled. De-interlacing should generally be
disabled, unless the material has been post-edited, or is a mix of film and broadcast source.

The Inverse Telecine filter should be used both for full screen (720/704/640) and "quarter
screen” (352/320 x 240) captures, as long as the source is 24 fps film.

Note: If you have chosen the “Inverse Telecine” Filter, leave the setting at 30 fps. The filter
will still generate a 24 fps encode, following the pattern of the source AVI if from a film transfer.

De-Interlace
For video taped content, such as news, sports, and TV Promos, select “ De-Interlace Filter” .

When the source material is from a broadcast 29.97 fps source, and the number of lines is
above 240, the original AVI will have interlace artifacts, in the form of sharp jagged edges on
moving object. If this is the case, the “De-Interlace Filter” should be enabled.

For material that consists of a mixture or film and video taped content, select “Inverse
Telecine”, and “De-interlace Filter” if the number of lines is above 240.

Generally for video source, “Inverse Telecine Filter” should be disabled, unless, as mentioned
in the section above, if the material is a mix of film source and broadcast material, both De-
interlacing and Inverse Telecine should be enabled.

High Quality Resize

The RealNetwork’s Video Solutions/Demo Lab prefers to generate from digital source, full
screen, uncompressed AVI files encoding and resizing with the RealProducer Plus 8.5,
enabling the “High Quality Resize Filter”.

Refer to the section “Selecting Video Settings” for information on targeting window sizes and
aspect ratios.

Notes on Third Party AVI Resize & Export Tools:

Using 3" party tools, full screen AVI's or edited sequences are often resized in software before
exporting to RealProducer. Even when adding the “De-Interlace” filter option in these
applications, some software resize exports can reduce the quality of the video source whereas
RealProducer Plus will not. Some video cards that provide hardware scaling (such as the
Targa 3000 series) will produce a high quality resize. Testing of resizing is suggested if
highest quality video is preferred.
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Selecting Video Codecs
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Image details the dialog box for Advanced Preferences under the Options menu.

Recommended Settings:
Video Codec: leave setting at "RealVideo 8.0"

Select "2-Pass Encoding" and "Variable Bit Rate Encoding” for optimal video quality and
playback performance.

Suggested: leave "Loss Protection" unchecked unless your content is to be streamed over
networks with severe packet loss.

Two-Pass Encoding

With Two-Pass encoding, which is used only when encoding from a digitized source file,
RealProducer runs through the entire source video once to gather information about how best
to encode the streaming clip. It then makes a second pass to encode the streams. Two-pass
encoding can substantially increase clip quality, but it requires more encoding time. The first
pass takes about as long as it would to encode the source file for one target audience.

Although two-pass encoding helps when you use constant bit rate encoding, it provides greater
benefit for variable bit rate (VBR) encoding, which is described above. With two pass
encoding, RealProducer can analyze the entire video file to determine how best to vary the
playback bit rate through the length of the clip. Without two-pass encoding, RealProducer
sequentially analyzes small sections of the source file during encoding, creating a string of
VBR sections within the clip.
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Variable Bit Rate Encoding

Variable bit rate (VBR) encoding varies a RealVideo clip’s playback bit rate, giving more
bandwidth to scenes that are hard to compress, and less to scenes that are easy. Compatible
with SureStream and broadcasting, VBR encoding generally provides superior video quality to
constant bit rate (CBR) encoding, which RealProducer uses if you do not select the VBR
option. VBR makes the most difference in videos that have a mix of high-action and low-action
scenes because it can steal bandwidth from low-action areas to give to high-action areas. This
is particularly useful for improving video quality at low bit rates.

To illustrate how VBR encoding works, suppose you encode a video for a DSL/cable modem
audience at 225 Kbps. With CBR, the video gets 225 Kilobits of encoded data each second.
With VBR, though, each second of video may be encoded at a different rate. One second may
have 150 Kilobits of data, for example, while another second has 300 Kilobits. The VBR clip
will have a streaming bit rate of 225 Kbps, though, just like a CBR clip. So you do not need to
worry that a VBR clip will underuse or overload a connection’s bandwidth.

A VBR-encoded video that starts with a high action scene needs a spike of bandwidth right
away. If there are no preceding troughs to carry this data, RealPlayer has to buffer the clip
longer. That means it may take the VBR clip longer than a CBR clip to start playing back.
RealProducer lets you set the maximum time RealPlayer needs to buffer the clip, though, to
ensure that the initial buffering time remains acceptable.
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Selecting Advanced Video Codec Settings

Geneial | SureSiream | Live Broadcast |
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Image details the dialog box for Advanced Preferences under the Options menu.

Recommended Settings:
Maximum Startup Latency: Leave the default settings at 15 seconds.

Maximum Time Between Keyframes: Leave at 10,000 milliseconds.

Maximum Start-up Latency

The “VBR Maximum Startup Latency” field affects only RealVideo clips encoded with a
variable bit rate (VBR). f VBR sections within the clip.
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Variable Bit Rate Encoding: A VBR video that starts out with a high-speed scene needs
more initial buffering because the first scene is encoded at a playback bit rate higher than the
audience connection speed. Because RealServer can't stream the scene faster without
overloading the connection bandwidth, it streams it longer to deliver the extra Kilobits needed.

The latency field determines how long RealPlayer viewers may have to wait before a VBR
video starts back. The default value of 15 seconds means that no matter how complicated the
video’s first scene, RealProducer will encode it so that it requires no more than 15 seconds to
start playing. The field sets a maximum value only, and RealVideo VBR clips may start
playback sooner. You can change the maximum to a whole value from 5 seconds to 25
seconds.

The value of 15 seconds is RealNetworks’ recommendation. Keep in mind that this represents
15 seconds of clip data buffering, and does not include the time it takes to launch RealPlayer,
find the host RealServer, send the request, and receive the host’s response. If a low start-up
time is critical, lower the latency time to 10 seconds, for example. For comparison, constant bit
rate clips are encoded to have a latency of about 5 seconds. If initial image quality is crucial,
you can raise the latency time, but this may cause restless viewers to stop the presentation
before it begins playback.

Maximum Time Between Keyframes

RealProducer encodes full data for a frame in a keyframe. Successive frames encode just the
data that describes how they vary from the preceding frame, starting with the keyframe. The
settings field is initially set to 10,000 milliseconds, meaning a constant or variable bit rate
RealVideo clip has a keyframe at least every 10 seconds. The main reason to change the
maximum rate is to lower it, although you should do this with caution. Lowering the rate
generates more key frames for clips and provides several benefits:

®  Minimizes distortion when streaming in a lossy environment.
®= Improves RealPlayer’s ability to seek to specific points in the RealVideo timeline.

®  Adds flexibility for editing RealVideo clips through File>Edit RealMedia File. You have
to cut a RealVideo clip at a keyframe, for example. More keyframes means more
precise control over where the cut occurs.

Because keyframes encode much more data than other frames, though, lowering the
maximum time between keyframes can lower the clip’s image quality if you do not also raise
the clip’s streaming bandwidth. If you change the keyframe rate, test the clip quality to
determine if the modification produced the desired results.
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Selecting Target Audience Settings
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Image details the dialog box for Advanced Preferences under the Options menu.

Recommended Settings:

Target Audience: Select your Target Audience setting to reflect your choice on the main
interface.

Frame Rate: Leave the “Max Frame Rate” default to 30 fps.

Remains the same when selecting “Inverse Telecine Filter”.
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Selecting Target Audience and Bit Rates
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Image details the dialog box for Advanced Preferences under the Options menu.

Recommended Settings

Target Audience: Select the setting to match the setting you have selected on the main

interface.

Bit Rate: Choose either from the default settings in the pull down menu, or enter your target

bit rate manually in the available field in kilobytes per second.

Default bit rates for the Kbps pull down menu are indicated in this section.

The maximum bit rate setting allows up to 5000 Kbps (5.0 Mbps) bit rates.

Broadband Tip: For bit rates above 200kbps, target 30 fps in 320 pixel window width or
greater. For bit rates below 200 kbps, average 15 fps in 200 pixel window width or smaller.
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Selecting Video Settings
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Image details the dialog box for Advanced Preferences under the Options menu.

Recommended Settings

Instructions are below for determining when to crop, resize and “Maintain Aspect Ratio”.

Input from Quarter Screen Video Source

If you need to resize or crop your quarter screen (352 or 320 width) source file, set the window
size to one of the following window sizes suitable for current broadband streaming standards:
— refer to chart at head of this document.

Letterboxed souce captures: use the cropping settings in the RealProducer Plus to remove
the black bars along the upper and lower window for a streamlined experience.

Broadband Tip: For broadband content up to 500 kbps, a window width of 352 or 320 is a
standard presentation measure.

Input from Full Screen Video Source:

For full screen AVI's, cropping all four sides of an AVI capture window is usually necessary.
The black edges are due to the over-scanning of the video image during capture. Black edges
also occur in letterbox source —see above.

Use the crop preview window to adjust the horizontal and vertical cropping measures.
Generally 8 pixels on for each edge is a good starting point.
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Input from Full Screen Video Source: Continued
Select “ Enable Resizing” and uncheck "Maintain Aspect Ratio".
For resizing widths between 320 to 640, refer to the aspect ratio instructions below.

For standard fullscreen, computer-displayed presentations, set the width to 640. The
height in the resize box should remain the same as the height determined in the crop
setting

Broadband Tip: If the first video frame is black, and you only see black in the crop preview
window, then approximate the crop settings, turn off “2-Pass Analysis”, and run a quick encode
for a several seconds. Watching your output window will allow you to view where the cropping
occurs. Remember to turn on “2-Pass Analysis” when to begin the final encode.

You can also open the AVI in mplay32.exe (or mplayer.exe on 98), and align this player over
the crop preview window to help to select the proper cropping measures.

Aspect Ratios

For both full size and quarter size AVI's, it is important to be aware of the aspect ratio as the
computer screen pixel aspect ratio is different than the aspect ratio on a TV monitor.

If the original AVI source is already 320 or 640 wide, and appears to be aspect ratio corrected,
you should then leave the "maintain aspect ratio" option checked, if additional resizing is
necessary.

However, in most other cases following the steps below will provide the best results:

AVI source widths between 704 to 720 should be resized to 640 output for fullscreen
presentations. Make sure you do not resize the height -as discussed above.

When resizing full screen AVI source widths to an output window size between 320 to 640,
scale the aspect ratio manually. In most cases when leaving the “Maintain Aspect Ratio”
setting checked, the result may appear slightly stretched. This may often go unnoticed.

AVI source widths near 352 can be resized to 320, to maintain a 4:3 aspect ratio. Leaving the
352 AVI source at 352 during encoding can also suffice, although there may be some chances
of stretching. This may often go unnoticed.

Viewing & Using Video Quality Statistics While Encoding

Understanding the “ Video Quality Index”

The “Video Quality Index” is the most essential tool to analyze your video. The quality index is
reported from the codec internals and provides a very useful indication of the video quality.

Where and When to Use the Tool

You can find the “Video Quality Index” by clicking View->Statistics, and then clicking the Video
tab. In the RealPlayer G2 section, there is a list of the streams you are encoding. For single-
rate there will only be one. The next to last column contains the video Quality Index. You
should examine this quality index while you are encoding. For 2-pass, it only makes sense
during the 2nd pass.
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Overspending Bits

If you see that the index is 94 or above, consistently, then you know the tools is overspending
bits. Consider one of the following practices when this occurs:

1. Lower the bit rate to save bits without sacrificing much quality,
2. increase the resolution, without increasing the bit rate,

3. increase the target frame rate, as long as it is not already at the maximum. Note that
the encoded frame rate is limited by the source frame rate (the first choice will save
bit rate, and the two others choices will increase video quality).

Poor Quality

If the number is constantly below 40, or even lower, you are running very low on bits, and if
you cannot increase the bit rate, you should consider lowering the resolution or target frame
rate you are encoding for.

Best Target

In general, the RealVideo 8.5 codec is most efficient when it can operate in the range between
60 and 94. If your target is very high quality, you should try to keep it above about 80, but not
so high that you are overspending (see above).

Playback: Using the RealPlayer8 for best possible playback

Fullscreen playback looks & plays better than ever in the RealVideo8 player.

For users of RealPlayer 7 or 8, an Auto-Update is available to upgrade to the RealPlayer8
(approx. 150k download size).

To ensure the best possible Broadband Experience at full screen playback in RealPlayer8,
refer to the section on upgrading video graphic display cards; also, ensure the system has at
least a 400 MHz processor.

Users of the G2 RealPlayer (vers.6) or earlier, will be prompted to upgrade the complete
player.

©2000 RealNetworks, Inc. All rights reserved.
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